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1 Introduktion

3DSMax (förr 3D Studio Max) är ett komplett mjukvarupaket fr̊an Autodesk för model-
lering, rendering och animering. Programmet är s̊a stort att det är sv̊aröversk̊adligt för
nybörjare, och den här labserien är avsedd som en vägledning för att förklara grunderna
i hur man arbetar med programmet. 3DSMax har verktyg för att göra följande:

1. Modellering av objekt i 3D.

2. Skapa material och texturer och lägga dessa p̊a ytan av objekten.

3. Ljussättning av scenen som skapats.

4. Rendering av de tredimensionella modellerna med applicerade material och ljus-
sättning, vilket innebär att scenen ”fotograferas” fr̊an den virtuella kamerans posi-
tion.

5. Animering av de tredimensionella modellerna, allts̊a att sätta dem i rörelse.

6. Import av 2D- och 3D-modeller skapade med andra design- och CAD-program.

7. Export av modeller för vidare användning i andra program.

8. Viss begränsad efterbearbetning av bild- och videomaterial.

2 Hjälp

Observera att det finns ett mycket omfattande, professionellt producerat och välskrivet
material för hjälp och stöd i 3dsMax, i menyn ”Help”. Använd i första hand detta när
du undrar över n̊agot i programmet. YouTube och slumpmässiga sökningar p̊a Google
kan visserligen ge vettiga alternativ ibland, men oftast är det man hittar gammalt, och
skrämmande ofta är det ren dynga. Du bör ocks̊a fr̊aga dig själv om det är ”lättare” att
titta p̊a en tio minuter l̊ang video p̊a YouTube som eventuellt visar hur man gör än att
läsa ett garanterat relevant stycke i ett sökbart och väl illustrerat skriftligt dokument.
Kort sagt: Använd Autodesks hjälp till programmet.

3 Att starta programmet, fönstrets utseende

Startar programmet gör man enklast genom att klicka p̊a genvägen p̊a skrivbordet med
namnet Autodesk 3dsMax 2017 (English). Skulle genvägen inte finnas där kan du hitta
programmet i Start-menyn under rubriken ”Autodesk”. Efter att du startat programmet
kommer du eventuellt att f̊a n̊agra fr̊agor om hur programmet skall se ut och bete sig.
Välj i s̊a fall det första alternativet (default) i alla fr̊agor. När programmet startar möts
du av ett fönster enligt figur 1. Fönstret best̊ar huvudsakligen av nio arbetsytor som
vi kommer att beröra översiktligt här. För en mer utförlig beskrivning av alla detaljer
rekommenderas programmets inbyggda hjälpsystem och medföljande tutorials.
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Figure 1: 3dsMax huvudfönster vid uppstart

Den här vyn med fyra viewports gör scenens 3D-struktur tydlig, men om du har ont
om skärmyta eller vill fokusera p̊a en viss viewport kan du klicka p̊a det lilla plustecket
längst upp till vänster i n̊agot av vyfönstren (röd ring i figuren nedan) och välja Maximize
viewport eller trycka Alt-W. För att g̊a tillbaka, välj Restore viewport, eller tryck Alt-W
igen. Om du har startat i ett läge där programmet visar Scene Explorer, en panelen till
vänster om 3D-fönstren som visar en schematisk vy av alla objekt i scenen, s̊a kan du
stänga den för att f̊a mer skärmyta. Den panelen är praktisk när man jobbar med stora
och sv̊aröversk̊adliga scener, men den är inte s̊a användbar för de enkla scener vi kommer
att ha i de inledande laborationerna. För att visa och ta bort Scene Explorer finns det en
knapp Toggle Scene Explorer i verktygslisten högst upp (markerad med gul ring i figur 1).

3.1 Menus

Menyerna överst i fönstret är vanliga Windows-menyer med en rad olika kommandon
och underkommandon i flera niv̊aer. Det mesta av det som finns i menyerna finns ocks̊a
åtkomligt p̊a ett eller flera andra ställen i gränssnittet, och i vissa fall även som snabbkom-
mandon via tangenttryckningar. Menyerna är sällan det smidigaste sättet att komma åt
en viss funktion, men det är en smaksak vilket man föredrar.

3.2 Toolbar

Toolbar är den samling av knappar som ligger strax under menyraden. Den inneh̊aller
de verktyg som används oftast. Till skillnad fr̊an de flesta andra Windows-applikationer
finns en del av dessa verktyg endast i Toolbar och inte i menyerna. De flesta av dem pre-
senteras nedan. Vissa begrepp förklaras senare eller förbig̊as utan förklaring. Fullständig
information finns i hjälpsystemet.
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3.2.1 Undo, Redo

Dessa fungerar likadant som i andra program. Man kan ångra och sedan ångra att
man ångrade sig. Undo finns ocks̊a som vanligt p̊a Ctrl-Z, och Redo n̊as via Ctrl-Y. Dock
finns här en extra liten finess. Du kan högerklicka p̊a knapparna och välja i en lista hur
många steg du vill ångra. Detta medför att du kan ångra många redigeringar p̊a en g̊ang
utan att klicka som en tok p̊a knapparna. Detta med att högerklicka, klicka p̊a ett särskilt
ställe eller h̊alla nere musknappen för att se alternativa funktioner finns p̊a flera knappar,
s̊a kika gärna p̊a vad det döljer sig för funktioner även under de andra knapparna som
g̊as igenom nedan.

3.2.2 Select and Link

Du kan definiera en hierarkisk relation mellan tv̊a objekt genom att länka dem som
”barn” och ”förälder”. Du kan länka tv̊a objekt genom att klicka p̊a denna knapp och
sedan dra en linje fr̊an det aktiva objektet (barn, child) till ett annat objekt (förälder,
parent). Du kan ocks̊a länka grupper av objekt p̊a detta sätt. När du gör det, blir hela
gruppen barn respektive förälder i relationen. Ett barn ärver transformationer (transla-
tion, rotation, skalning) som görs p̊a föräldern, men transformationer gjorda p̊a barnet
har ingen effekt p̊a föräldern. S̊adana här hierarkiska transformationer är väldigt centrala
i datorgrafik när man jobbar med med större scener och mer komplicerade objekt.

3.2.3 Unlink Selection

Du kan ta bort den hierarkiska relationen mellan tv̊a objekt genom att först välja
barn-objektet som du vill avlänka och sedan trycka p̊a denna knapp.

3.2.4 Bind to Space Warp

Du kan binda ett objekt till en Space Warp genom att markera objektet, klicka p̊a
denna knapp och dra en linje fr̊an objektet till Space Warp-objektet. Space Warps
används för att deformera och animera objekt, och behandlas utförligare i programmets
hjälpsystem.

3.2.5 Selection Filters List
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Du kan välja vilka typer av objekt du vill skall kunna bli markerade med mark-
eringsverktygen. Eftersom många objekt ofta överlappar varandra p̊a skärmen är det
ibland lätt hänt att man pekar p̊a fel sak eller f̊ar med n̊agot annat i markeringen av
misstag. D̊a kan selection filters hjälpa.

3.2.6 Select Object

Du kan markera objekt genom att klicka först p̊a denna knapp och sedan p̊a det eller
de objekt du vill markera. Om du vill markera flera objekt h̊aller du nere ctrl -tangenten
för de följande objekten. För att avmarkera ett objekt, h̊all nere alt-tangenten och klicka.

3.2.7 Rectangular Selection Region

Du kan markera ett eller flera objekt genom att först klicka p̊a denna knapp och sedan
dra en rektangel som skär eller omsluter objektet/objekten.

3.2.8 Window/Crossing Toggle

När du markerar objekt genom att dra ut en rektangel eller liknande kan programmet
antingen markera de objekt som är helt innanför rutan eller dem som bara genomskärs
av rutan. Vilket som skall gälla väljer du med denna knapp. Window är att objekt blir
markerade endast om de är helt innanför rutan, och Crossing väljer att de ska markeras
även d̊a de bara nuddas av markeringen.

3.2.9 Select by Name

Du kan markera ett eller flera objekt genom att välja deras namn fr̊an den lista du
f̊ar upp när du klickar p̊a denna knapp. I en stor scen är det ofta sv̊art att klicka p̊a rätt
objekt ute i vyn, s̊a listan är bra att ha. För att listan ska vara användbar krävs först̊as
att du har gett dina objekt vettiga namn när du skapade dem. Tänk p̊a detta!

3.2.10 Select and Move

Du kan flytta de markerade objekten med denna knapp. Det dyker upp en s.k. gizmo
som du kan dra i för att flytta objekten. Det finns olika omr̊aden p̊a denna som väljer

6



hur du ska flytta saker och ting. Om du tar tag i pilen p̊a en enskild axel (x, y eller
z) s̊a flyttar du enbart längs den axeln. Om du tar tag i n̊agon av de tre små rutorna
som dyker upp vid basen p̊a axlarna när du kommer dit med musen s̊a flyttar du i det
planet. Om du till exempel tar tag i planet som är mellan axeln x och y s̊a kommer du
att kunna flytta objektet i x/y-planet. Rotate och scale har liknande gizmos. För en
ing̊aende förklaring av dessa hänvisas till hjälpsystemet. Du kan naturligtvis ocks̊a pröva
dig fram.

Om du vill skapa en kopia av ett objekt kan du h̊alla ner shift-tangenten medan du
flyttar det. D̊a skapas en eller flera kopior i stället för att du flyttar p̊a originalet.

3.2.11 Select and Rotate

Du kan rotera de markerade objekten med denna knapp. Eftersom rotationer i 3D
kan ske runt olika axlar s̊a f̊ar du välja axel genom att peka p̊a rätt ställe p̊a den gizmo
som dyker upp.

3.2.12 Select and Uniform Scale

Du kan skala (ändra storlek p̊a) objekt genom att klicka p̊a den här knappen, välja
objekt och skala objekten genom att klicka och dra med musen p̊a den gizmo som dyker
upp.

3.2.13 Select and Place

Den här knappen gör att objekt som flyttas försöker hitta ett sätt att lägga sig p̊a ytan
av andra närliggande objekt, vilket är praktiskt när man placerar ut objekt p̊a ojämna,
lutande eller krökta ytor.

3.2.14 Reference Coordinate System

Du kan ange vilket koordinatsystem som skall användas för transformationer (flyt-
tning, rotation, skalning). Det är ofta praktiskt att kunna transformera ett objekt i sitt
eget, lokala koordinatsystem, eller till och med i n̊agot annat objekts koordinatsystem, i
stället för att alltid använda scenens koordinatriktningar.
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3.2.15 Use Pivot Point Center

Det här är en lista med tre val som bestämmer runt vilken punkt som rotationer och
skalning skall genomföras. Pivot point center roterar varje objekt kring sitt eget origo. Se-
lection center roterar den aktuella markeringen kring de ing̊aende objektens gemensamma
medelpunkt. Transform coordinate center roterar kring det aktuella koordinatsystemets
origo.

3.2.16 Select and manipulate

Den här knappen gör att du visuellt och direkt kan ändra vissa inställningar för vissa
speciella objekt, manipulators. För mer detaljer om detta hänvisas till hjälpsystemet.

3.2.17 Keyboard Shortcut Override Toggle

Med hjälp av denna knapp väljer man mellan att använda de vanligaste kortkomman-
dona (tangentbordstryckningar som ersätter vanliga menyval och knappar i gränssnitter)
eller att dessutom använda kortkommandon för vissa särskilda redigeringsverktyg i pro-
grammet. Kortkommandon är bra att ha om man vill jobba snabbt och effektivt i pro-
grammet, men de är inte nödvändiga. För detaljer om detta, se hjälpsystemet.

3.2.18 3D Snap Toggle

Denna knapp är till för att l̊asa det du skapar och flyttar p̊a mot ett koordinatsystem
som du bestämmer. Hjälpen förklarar hur den fungerar. Den kan dels l̊asa mot koordi-
natsystemet p̊a skärmen, men ocks̊a mot linjer, punkter och ytor i scenen. Det här är ett
n̊agot komplicerat men mycket användbart verktyg som kan underlätta modellering och
placering av objekt i en stor scen.

3.2.19 Angle Snap Toggle

Du kan l̊asa rotationer till vissa bestämda gradtal när du roterar genom att trycka in
denna knapp. För att ändra vilka steg den l̊aser till, högerklicka p̊a knappen för att f̊a
upp en ruta med inställningar.

8



3.2.20 Percent Snap Toggle

När du ändrar saker som anges i procent, till exempel när du skalar objekt, s̊a kan du
använda denna för att l̊asa till fasta steg. Högerklicka för att ange stegets storlek.

3.2.21 Spinner Snap Toggle

Spinners är värdeangivelser i textrutor med upp- och nedpilar intill sig. S̊adana finns
i stort sett överallt i gränssnittet. Här här kan du ställa in olika stora steg när du ändrar
p̊a spinners, till exempel när du ändrar storleken p̊a en sfär som du precis skapat.

3.2.22 Edit Named Selection Sets, Named Selection Sets

Du kan välja en uppsättning objekt och ge dem ett gemensamt namn, för att enkelt
kunna välja dem igen. Det här är inte samma sak som att gruppera objekten, eftersom
Named Selection Set inte l̊aser deras position gentemot varandra. Först markerar du de
objekt du vill ska ing̊a i mängden, och sedan skriver du mängdens namn i rutan och
trycker Return. Du kan sedan markera samma urval när du vill genom att klicka p̊a
mängdens namn. En klok användning av lager (layers), grupper (groups) och s̊adan här
selection sets är nästan oumbärligt när man börjar modellera mer komplicerade objekt
och scener. Det är annars väldigt lätt att g̊a vilse i en ostrukturerad soppa av ogrupperade
objekt som har illa valda, intetsägande namn som t ex ”Box093”.

3.2.23 Mirror

Du kan spegelvända ett eller flera valda objekt. När du klickar p̊a denna knapp öppnas
ett fönster där du kan ändra inställningarna och se resultatet av dina ändringar i vyerna.

3.2.24 Align

Align öppnar en egen dialogruta som inneh̊aller verktyg för att rikta in och placera ob-
jekt i förh̊allande till andra objekt i scenen, eller i förh̊allande till kameror. Det finns flera
andra underfunktioner p̊a den här knappen, men för en fullständig genomg̊ang hänvisar
vi till programmets inbyggda hjälpsystem.
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3.2.25 Toggle Scene Explorer

Öppnar och stänger en lista över alla objekt där man kan välja dem p̊a namn i stället
för att peka p̊a dem i scenen. Mycket användbart för stora scener. Kräver att objekten
getts n̊agorlunda beskrivande namn. Scene Explorer kan dockas fast p̊a endera sidan om
dina viewports om du vill ha den uppe för jämnan.

3.2.26 Toggle Layer Explorer

Öppnar en editor för att hantera lager. Lager är ett sätt att strukturera en stor scen
i löst grupperade delar som p̊a n̊agot sätt har med varandra att göra, ungefär som det
fungerar i de flesta 2D-ritprogram. Lager har inget med ”över” och ”under” att göra som
det har i 2D-sammanhang, men ett lager kan visas och gömmas som en enhet. Layer
Explorer kan dockas in bland dina viewports om du vill ha den tillgänglig hela tiden.

3.2.27 Toggle Ribbon

Denna knapp aktiverar en rad med knappar och ikoner som ligger under den huvusak-
liga toolbar. Där finns samlingar med verktyg som är specialdesignade t ex för att utföra
olika slags modellering. ”Ribbon” är ett dynamiskt verktygsfält i stil med vad som finns
i vissa andra Windows-program, och som man själv kan modifiera för att passa ens egna
behov. Vi kommer inte att g̊a in p̊a detta närmare, men det är ett smidigt sätt att effek-
tivisera arbetet om man märker att man ofta upprepar samma handgrepp i programmet
och de känns kr̊angliga, till exempel för att funktionerna ligger l̊angt ifr̊an varandra i
gränssnittet.

3.2.28 Curve Editor

Inneh̊aller de verktyg som behövs för att jobba med Tracks och Function Curves i
animering. (I tidigare versioner av programmet öppnades den kompaktare vyn Dope
Sheet, men numera används Function Curves som standardvy. Den gamla vyn med
endast keyframes finns som alternativ i menyn ”Editor → Dope Sheet” när man öppnat
Curve Editor.)

3.2.29 Schematic view
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Här finner du en editor och vy för hur dina objekt förh̊aller sig till varandra och vilka
material de har. Det är en schematisk översikt över hela din scen. Tyvärr är den inte s̊a
översk̊adlig, men den kan vara bra att ha i vissa fall. Många andra 3D-program har en
bättre schematisk vy, som d̊a ocks̊a är mer central för hur man jobbar i programmet.

3.2.30 Material Editor

Inneh̊aller funktioner för att skapa och redigera materials och maps. Detta behandlas
utförligare i laboration 2.

3.2.31 Render Setup, Rendered Frame Window, Render Production

Dessa knappar har med renderingen att göra, allts̊a den del av programmet som räknar
ut en bild av din scen, med hänsyn taget till ljussättning, skuggor och alla material.
Rendering behandlas litet närmare i laboration 3. Det finns en uppsjö av inställningar
för att styra renderingen, varav de vanligaste sitter direkt p̊a renderingsfönstret. De flesta
innebär n̊agot slags kompromiss mellan realism och hastighet. Bra bilder tar oftast l̊ang
tid att rendera. Snabba renderingar blir sällan snygga.

3.2.32 Render in the Cloud, Open Autodesk A360 Gallery

De här knapparna har att göra med Autodesks ”cloud rendering”, en kommersiell
tjänst som gör att man kan rendera p̊a deras datorer p̊a nätet i stället för att behöva
investera i egna datorresurser. Kostnadsfria studentlicenser och rabatterade licenser för
utbildningsbruk har inte tillg̊ang till denna tjänst.
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3.3 Command Panel

För att skapa och redigera objekt används Command Panel, den breda vertikala panelen
längst till höger. Det finns sex olika knappar överst i Command Panel :

3.3.1 Create

Det finns sju olika knappar överst p̊a Create Panel för att skapa olika saker: Geometry
(3D-objekt, t.ex. box, sfär, kon), Shapes (2D-objekt, t.ex. linje, cirkel, ellips), Lights
(ljuskällor), Cameras (kameror för att bestämma vyn för rendering), Helper (för att t
ex skapa stödlinjer), Space Warp (för att exempelvis tänja och deformera objekt) och
Systems. Varje avdelning har sedan i sin tur n̊agra olika underavdelningar. Bekanta dig
gärna litet närmare med vad som finns genom att bläddra runt i panelen, och se vilka
varianter man kan välja.

3.3.2 Modify

Används för att modifiera det markerade objektet. Objektets namn visas överst p̊a
panelen och under det visas en samling av tillgängliga Object Modifiers. Modifiers lägger
sig p̊a en modifier stack, som syns under Modify-fliken. Modifier -stacken är mycket central
när man gör modellering och animering i 3DSMax, och många andra 3D-program fungerar
p̊a liknande sätt.

3.3.3 Hierarchy

Används för att jobba med funktioner relaterade till hierarkiskt länkade objekt, ex-
empelvis att flytta p̊a deras lokala origo (pivot point).

3.3.4 Motion

Ger tillg̊ang till de verktyg som anpassar det markerade objektets rörelse i ani-
meringar.

3.3.5 Display
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Kontrollerar hur objekt visas i vyerna (Viewports). Man kan exempelvis välja att
gömma ett objekt för att göra scenen mindre plottrig medan man jobbar, eller visa vissa
särskilt komplicerade objekt som enkla boxar för att snabba upp och förenkla arbetet
med scenen.

3.3.6 Utilities

Inneh̊aller n̊agra allmänna extra funktioner som används i 3DSMax. Fler ”utilities”
kan definieras p̊a olika sätt, antingen genom ”plug-ins” som programmeras i C++ eller
med scriptprogrammering i ett inte s̊a himla bra men änd̊a ganska användbart program-
meringsspr̊ak som heter MaxScript, eller i det modernare spr̊aket Python. Detta ligger
dock l̊angt utanför ramen för dessa inledande laborationer.

3.4 Time Controls

Time Controls best̊ar av en bred time slider precis under vyerna (viewports) och
ovanst̊aende knapparna i panelen längst ner i fönstret. Här kan du skapa och redigera
animationer genom att sätta keyframes, keys, för olika egenskaper. Man kan animera i
stort sett vilka egenskaper som helst hos objekt. Allt som kan ställas in med en spinner
g̊ar att animera. Förutom position och riktning för objekt kan man ändra exempelvis
färg och form.

Man kan animera med keyframes p̊a tv̊a olika sätt. Dels kan man använda Auto
key. D̊a flyttar man helt enkelt time slidern och flyttar och ändrar sina objekt fritt. D̊a
kommer det att sättas en keyframe s̊a snart när man ändrar n̊agot. I många fall är det
sv̊art att f̊a exakt det resultat man vill med denna metod, och det kan bli onödigt många
keyframes att h̊alla reda p̊a. D̊a kan man i stället trycka in Set Key s̊a kan man flytta,
rotera, skala och modifera objekten fritt. Det sätts en keyframe först när man trycker p̊a
den stora plus-knappen med en nyckel. Mer om detta finns att läsa i hjälpen.

Animationskontrollerna tas inte upp i detalj här. Vi återkommer till dem senare, i
laboration 4.

3.5 Vyer (Viewports)

De fyra stora fönstren som täcker den största delen av huvudfönstret är vyerna, View-
ports. De används för att titta p̊a scenen fr̊an olika vinklar. Fr̊an början (efter att man
återställt standardvyn med Restore viewports, se inledningen) ser man fyra lika stora
vyer. Längst ner till höger finns perspektiv-vyn som kan visa scenen fr̊an vilken vinkel
som helst. Övriga fönster visar ortografiska vyer, vilket betyder att du kan se scenen
parallellprojicerad (utan perspektiv) längs endera av x-, y och z-axlarna. Antalet vyer
och deras typ kan ändras. Ofta vill man i stället jobba med flera perspektivvyer, till
exempel kopplade till var sin kamera i scenen.
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Om du har en liten skärm med l̊ag upplösning, t ex en mindre laptop, s̊a kan det bli
väldigt tr̊angt om utrymme för att visa 3D-vyerna. Det blir bättre om du stänger alla
extra paneler som till exempel Scene Explorer (se inledningen), men det är fortfarande
sv̊art att jobba med 3dsMax om man har en skärm med l̊ag upplösning. Dels är det
många saker som ska f̊a plats i huvudfönstret, dels öppnas det en rad extra fönster för
olika ändamål. En HD-upplöst skärm är bra att ha, och det skadar inte att ha en ännu
större skärm, eller flera skärmar, när man jobbar med programmet.

3.5.1 Konfigurering av vyer

Vyernas typ och uppdelning kan ändras i vyns konfigurationsdialog. (Views → View-
port Configuration). En praktisk genväg är att högerklicka p̊a vyns beteckning i view-
porten(t ex Top). D̊a f̊ar du upp en meny där vyns inställningar kan ändras.

3.5.2 Aktivering av vyer

Modellering och animering kan göras i vilken vy som helst. Medan du redigerar ett objekt
i en vy uppdateras alla övriga vyer. Du kan manipulera objekten i perspektiv-vyn och
observera deras förändringar i de tre ortografiska vyerna, eller du kan manipulera dem i
varje ortografisk vy för att f̊a mer kontroll. Det är helt och h̊allet upp till dig hur du vill
jobba, men glöm inte bort de ortografiska vyerna. De kan vara väldigt praktiska och ger
ofta bättre koll p̊a läget än perspektivvyn. Den vy du jobbar i blir det aktiva fönstret,
och det finns bara en aktiv vy åt g̊angen. Den aktiva vyn är omsluten av en gul ram
(eller en röd ram om du har aktiverat animering). En vy aktiveras s̊a fort du högerklickar
inom den. Ett vänsterklick fungerar ocks̊a, men det kan innebära att samtidigt som du
aktiverar vyn markerar du även ett objekt inom vyn. Ta för vana att alltid högerklicka
för att byta vy.

3.6 Viewport Navigation Controls

De knappar som sitter längst ner till höger i huvudfönstret är navigationsknapparna
för vad du ser i dina vyer. Knapparna ändrar din vy av scenen, men p̊averkar inte
objekten. Undantaget är om du har en vy kopplad till en kamera - d̊a flyttar du p̊a
kameran med dessa kontroller.

3.6.1 Zoom

Du kan zooma in/ut i den aktiva vyn genom att välja detta verktyg och sedan klicka
och dra i vyn med musens vänsterknapp. Musens scrollhjul fungerar ocks̊a för detta
ändamål, men s̊a sker den stegvis i steg som man inte riktigt har kontroll över hur stora
de blir.
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3.6.2 Zoom All

Du kan zooma in/ut samtidigt i alla vyer.

3.6.3 Zoom Extents Selected

Du kan zooma vyn s̊a att ett eller flera objekt lagom täcker hela fönstret. Om du har
ett eller flera objekt valda s̊a zoomas det s̊a att just det eller de objekten visas bra i vyn.
Om inga objekt är valda zoomas det s̊a att alla objekt i scenen syns. Detta kan vara
bra om man t ex tappat bort sig i vyn och inte hittar tillbaka, eller om ett objekt r̊akat
hamna l̊angt bort fr̊an de andra av misstag s̊a att man inte ser det.

3.6.4 Zoom Extents All Selected

Du kan zooma alla fönster samtidigt p̊a samma sätt som i 3.6.3. Observera att detta
zoomar olika mycket i olika vyer, vilket kan vara förvirrande.

3.6.5 Field of View (FOV)

I perspektivfönstret är effekten av att ändra Field of View (FOV) densamma som att
ändra brännvidden p̊a linsen p̊a en kamera. Det är detta som egentligen kallas ”zoom”
inom fotografi. (Det 3DSMax kallar ”zoom” kallas egentligen ”dolly” av fotografer, efter-
som filmkameror åtminstone förr i tiden var tunga och därför alltid stod p̊a en vagn, en
”dolly”, som dessutom ofta gick p̊a räls.) Undvik att ändra FOV till alltför stora eller
små värden. Effekten blir konstig och orealistisk. De förinställda valen för objektiv med
olika brännvidder p̊a en kamera representerar vanliga och vettiga värden.

3.6.6 Pan

Du kan flytta vyn i sidled eller i höjdled i den riktning du flyttar musen. (I film-
sammanhang kallar man egentligen dessa rörelser för ”truck” i sidled och ”pedestal” i
höjdled. ”Pan” avser egentligen en rotation i sidled, och ”tilt” är när man vinklar kam-
eran i höjdled. 3dsmax är slarvigt med begreppen här. Men åter till saken.)

3.6.7 Orbit SubObject

Du kan rotera vyn med rotationscentrum i ett visst objekt. Kameran roterar p̊a ett
fast avst̊and fr̊an detta objekt, och riktas hela tiden mot det objektet.
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3.6.8 Maximize Viewport Toggle

Du kan maximera/minimera storleken p̊a den aktiva vyn. Det är ofta praktiskt
att arbeta i en mer detaljerad maximerad vy, s̊a att man ser tydligare vad man gör med
objektet man h̊aller p̊a att ändra. Snabbkommandot för detta är Alt-W. Detta är ett
av de f̊a snabbkommandon som det verkligen är praktiskt att kunna även när man är
nybörjare.
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4 Laborationsuppgifter

4.1 Att skapa en enkel scen

I detta avsnitt ska vi lära oss att skapa enkla primitiver s̊asom sfärer, cylindrar, koner
och liknande. Börja med att göra reset (File → Reset) p̊a 3DSMax. Aktivera sedan
Perspektiv-vyn.

1. Tryck p̊a Create → Geometry.

2. Välj sedan Sphere och börja att rita direkt i perspektivfönstret.

3. Klicka p̊a det sista ordet i rubriken längst upp till vänster i din aktuella viewport,
där det st̊ar ”Default shading”. Välj i stället Wireframe Override eller Edged Faces
för att tydligt se polygonstrukturen för objekt som du skapar.

4. Klicka p̊a fliken Modify.

5. Under Parameters i modify finns det tv̊a kontrollknappar, Radius och Segments.
Prova och se hur de fungerar. Minska Segments till 4. Vad händer? Varför ändra
segments? Fundera p̊a vilka fördelar det kan vara med att använda f̊a/m̊anga
segment.

6. Prova nu att skapa en cylinder. (G̊a tillbaka till Create → Cylinder)

7. Gör som i punkt 3 ovan och klicka p̊a rubriken i viewporten för att byta stil p̊a det
som visas igen. Välj Facets den här g̊angen.

8. Markera cylindern.

9. G̊a till fliken Create och titta högst upp, där objektets namn och färg visas. Byt
namnet ”Cylinder01” till ”Cylinder” och ändra färgen till en lämplig färg genom
att klicka p̊a avsedda omr̊aden. Välj en ljus färg till dina objekt s̊a att de syns.

10. Gör nu som i steg 7 fast byt Facets mot Default. Vad händer?

4.2 Att modifiera ett objekt

Nu ska vi prova p̊a hur vi kan modifiera objekt och göra en modell son inte bara best̊ar
av primitiver i sin grundform. Vi skall göra en kaffemugg. Börja med att göra Reset p̊a
3DSMax. Aktivera sedan perspektivvyn.

1. Tryck p̊a Create → Geometry.

2. Välj Wireframe som renderingsmetod i vyn.
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3. Välj sedan Tube för att skapa en tub.

4. Klicka inte p̊a fri hand den här g̊angen, utan öppna undermenyn Keyboard Entry
i panelen.

5. Sätt Inner Radius till 39, Outer Radius till 43 och Height till 65. Tryck p̊a ”Create”,
och kalla objektet för ”vägg”.

6. Nu ska vi göra bottenplattan. Välj Cylinder och skapa en cylinder med lämpliga
dimensioner som stämmer med tuben du just gjorde. Kalla den för ”botten”. Se
figur 3.1.

7. Aktivera Top-vyn, markera ett av objekten.

8. Välj nu Align i menyn (Alt-A) eller i Toolbar och klicka p̊a det andra objektet. Nu
dyker det upp ett fönster (Align Selection). Här fungerar det s̊a att du väljer det
objekt du vill flytta, sedan väljer du Align och pekar p̊a det objekt du vill flytta i
förh̊allande till. Current object är det objekt som du hade valt och Target object är
det objekt som du pekade p̊a efter kommandot Align. Kryssa i X Position och Y
Position. Vad händer? Prova p̊a att kryssa i och ur de övriga rutorna och begrunda
skillnaden. Ändra ocks̊a mellan Center, Min och Max för de b̊ada objekten tills du
först̊ar hur det fungerar. Knappen Apply flyttar objektet men beh̊aller dialogrutan
öppen, s̊a att du kan göra flera olika Align-operationer i olika ledder utan att öppna
samma dialog flera g̊anger. Knappen OK utför operationen och stänger dialogen.

9. Du kan nu hälla i lite kaffe om du vill, genom att göra en annan cylinder med
lämpliga dimensioner och placera den med Align.

10. Nu ska vi börja med handtaget. Välj Box och rita en box.

11. Sätt Length till 10, Width till 4 och Height till 70. Sätt ocks̊a Height Segs till
20. Varför kommer du att se strax. Kalla objektet för ”handtag”.

12. Börja nu med att modifiera handtaget genom att välja Modify → Taper.

13. I Parameters, sätt Amount till 1 och Curve till –2.

14. Välj sedan Bend och sätt Angle till –180. Nu kan du i Modifier Stack välja Box.
Ändra antalet Height Segs tillbaka till standardvärdet 1. Vad händer? Varför?
Ändra tillbaks till 20 igen.

15. Nu när du har skapat handtaget gäller det att sätta fast det mot kaffemuggens
yttre vägg. Det kan lämpligtvis ocks̊a göras med Align, p̊a liknande sätt som ovan.
Eventuellt kan du behöva finjustera positionen manuellt s̊a att det inte blir en glipa
i skarven, men börja med en Align s̊a att handtaget sitter centrerat.

16. Muggen ser inte att vara särskilt behaglig att dricka ur. Öka antalet segment runtom
din Tube tills den ser tillräckligt rund ut.
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17. Nu är koppen rund, men överkanten ser ut som om man skulle skära sig p̊a den.
Runda av den med modifiern Chamfer. Studera vad som händer genom att visa
objektet i Wireframe-läge eller genom att sl̊a p̊a Edged Faces i din viewport.
Förmodligen kommer även kanterna runtom muggens yta att rundas av, vilket
inte är vad vi vill. Öka Min Angle för din Chamfer s̊a att bara de skarpa 90-graders
kanterna rundas av.

18. Den avhyvlade kanten är rak, vilket inte passar s̊a bra här. För att f̊a en mjukare
kant, g̊a in i inställningarna för Chamfer och öka Segments n̊agot, minska Tension
till omkring 0.5 och experimentera med Amount tills kanten är lagom rund.

19. Handtaget är ocks̊a för kantigt. Runda av det med modifiern MeshSmooth, som
är en av flera metoder som finns i programmet för s̊a kallad mesh subdivision.
För att se tydligare vad som händer, kryssa ur rutan Isoline Display i panelen för
MeshSmooth för att se alla de nyskapade polygonerna. Öka Iterations till 2 om
du vill ha handtaget ännu rundare. Mer än s̊a är förmodligen inte nödvändigt.
Akta dig för att öka Iterations alltför mycket, eftersom det kan bli väldigt många
polygoner som tar en förskräcklig tid att beräkna. I värsta fall kan programmet
sluta svara p̊a en stund eller rentav l̊asa sig om man r̊akar be om att f̊a miljontals
polygoner p̊a en dator som inte är toksnabb och har enorma mängder minne.

20. MeshSmooth och liknande metoder rundar av objekt, men gör dem ocks̊a litet
mindre. Flytta eventuellt in handtaget s̊a att det f̊ar kontakt med muggen igen,
och öka eventuellt storleken p̊a din Box i botten p̊a modifer-stacken s̊a att handtaget
blir lagom tjockt igen.

21. Glöm inte att spara filen med objektet. Kalla filen till exempel för mugg.max.

Figure 2: De olika delarna av en l̊agupplöst polygonmodell av en kaffemugg.
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4.3 Att skapa en banan

3D-modellering kan göras p̊a m̊anga olika sätt, och man kan spara mycket arbete p̊a att
hitta rätt verktyg för en viss uppgift. För att göra en banan använder man enklast Loft
för att göra själva modellen och sedan Smooth för att göra lagom rundade ytor p̊a bana-
nen. Loft-objekt är ett exempel p̊a s̊a kallade svepta ytor, tv̊adimensionella Shapes som
förflyttas längs en kurva för att skapa tredimensionella objekt. Många verkliga tillverkn-
ingsprocesser skapar objekt med s̊adan form, t ex stränggjutning och profilfräsning. Läs
mer om Loft under Help-menyn. Vi ska nu göra tv̊a shapes enligt figur 3.

1. För att göra linjen, börja med att rita en rak linje (Create → Shapes → Line)
i Front-vyn. Det gör du genom att först vänsterklicka n̊agonstans i vyn (start-
punkten) och släppa. Flytta sedan musen och klicka igen p̊a slutpunkten. Sedan
högerklickar du för att avsluta linjen. Nu är linjen markerad ocks̊a. Sedan väljer
du Modify i Command Panel. Klicka p̊a den lilla triangeln i Modifier-stacken, till
vänster om ordet ”Line”, för att komma till Sub-object niv̊an, och välj Vertex s̊a att
du kan justera enskilda hörnpunkter. Nu ser du en liten kvadrat vid linjens start-
punkt. Högerklicka p̊a startpunkten, och i fönstret som kommer upp, välj Bezier
eller Bezier Corner. Den gröna tangentpunkten som dyker upp kan du flytta med

move-verktyget för att ändra linjens krökning. Gör likadant med slutpunkten
p̊a linjen tills du är nöjd.

2. För att göra hexagonen, använd NGon. Det verktyget hittar du under Create →
Shapes → Spline → NGon.
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Figure 3: Tv̊a shapes som s̊a småningom kommer att bilda en banan

Nu ska vi förflytta hexagonen (Loft Object) längs linjen (Loft Path) och skapa en
yta:

3. Se till att du har linjen vald, g̊a sedan till Create → Geometry. Välj underavdel-
ningen Compound Objects och klicka p̊a knappen Loft.

4. Klicka nu p̊a Get Shape och markera sedan hexagonen.

5. Objektet vi skapade är jämntjockt längs hela sin längd. För att f̊a objektet att likna
en banan använder vi Deformations längst ner i Modify-fliken för Loft-objektet.
I Deformations väljer du Scale och arrangerar punkterna ungefär enligt figur 4.

Med knapparna och kan du flytta punkterna och ändra kurvans lutning

i punkten ifr̊aga. Med verktyget Insert Bezier Point kan du lägga till fler
kontrollpunkter längs linjen. Om du f̊ar ett hörn där du vill ha en mjuk kurva eller
tvärtom, högerklicka p̊a punkten och välj typ: Corner, Béziér-smooth respektive
Béziér-corner.
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Figure 4: Att justera bananens profil genom Deformations → Scale.

6. För att göra kanterna p̊a bananen mjuka kan man naturligtvis runda av hörnen i
själva modellen, men vi väljer att fuska och bara runda av normalerna. Markera
bananen, g̊a till Modify-panelen, och i listan med alla modifiers väljer du Smooth.
Klicka sedan i Auto Smooth. Det räcker inte bara med det, utan man måste ändra
litet p̊a värdet för vilken som är den största vinkel som ska mjukas till, (Threshold).
Prova att sätta den till ungefär 60. Nu kommer normalerna att interpoleras mjukt
mellan de polygoner som ligger närmast kanten, och bananen kommer att se ut att
ha mindre skarpa hörn.

7. Om du tycker att bananen ser för kantig ut för att den har för f̊a segment kan
du ändra antalet steg i Loft-objektet. Välj bananen, titta i Modify-fliken, öppna
underavdelningen Skin Parameters och ändra inställningarna för Shape Steps och
Path Steps. Prova ocks̊a att klicka i och ur kryssrutan Adaptive Path Steps. Hitta
en bra balans där du tycker att objektet ser bra ut utan att ha extremt många
polygoner.

8. Glöm inte att spara objektet. Kalla filen för n̊agot relevant, till exempel banan.max.
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4.4 Extra uppgift (Frivillig)

Skapa n̊agot annat objekt i mån av tid! Experimentera gärna p̊a egen hand, men glöm
inte bort hjälpen som finns tillgänglig genom att trycka p̊a F1 eller Help → User Ref-
erence. Det finns naturligtvis ocks̊a mycket att läsa p̊a nätet, men vi vill i första hand
rekommendera programmets inbyggda hjälpsystem. Det är välskrivet, korrekt, utförligt,
väl illustrerat och rent allmänt av garanterat god kvalitet, n̊agot som tyvärr inte kan
sägas om det mesta man hittar p̊a Internet. Dessutom är material p̊a nätet ofta skrivet
för en annan, tidigare programversion än den som är aktuell just nu. 3dsMax och liknande
program utvecklas ganska snabbt och ser n̊agot annorlunda ut i varje ny version.
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